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Before You Begin
This manual describes the Waveform Viewer and Waveform Editing tools.  

Note: The Waveform Editor is not provided with some products that use this manual.
If your base product is ABEL, you need to use only the chapters on the Waveform
Viewer.

The information found in each chapter is summarized below:

♦ Chapter 1, "Waveform Viewer" — Describes the Waveform Viewer.
♦ Chapter 2, "Waveform Editing Tool" — Describes the Waveform Editing

Tool.  ABEL does not use this tool.
♦ Chapter 3, Command Reference — A reference of commands in the

Waveform Viewer and Waveform Editing Tool, arranged by menu.
♦ Appendix A, Waveform Description Language — Information on the

Waveform Description Language.
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Chapter 1

The Waveform Viewer
The Waveform Viewer displays the results of logic or timing simulations. The
logic states of schematic nets are displayed as time-line traces (waveforms).
The nets whose waveforms are to be displayed can be interactively chosen
from the schematic. Query functions can be used to trace signals to their source
on the schematic. Trigger functions can be used to locate the occurrence of a
specific logic event. Delays between events can be measured with markers.
This chapter covers the following topics:

♦ Starting the Waveform Viewer
♦ Selecting the Waveforms to View
♦ Moving Around
♦ Analysis Techniques
♦ Saving and Printing Waveforms
♦ Waveform Viewer Configuration

Starting the Waveform Viewer
The Waveform Viewer is typically used in conjunction with a simulator. You
must run the simulator before you can run the Waveform Viewer; without
simulation information, the Waveform Viewer has no data to display.

Waveform Viewer Window

Figure 1-1 shows a typical Waveform Viewer display. The following is a
description of the elements of the Waveform Viewer window.

Title Bar The title bar across the top shows the name of the current
design. This name is the base name of the design being
examined.

Waveform
Name Area

This area contains the names of any waveforms displayed.
You can resize this area by placing the mouse cursor over
the vertical line between the name and display area, and
dragging the line where you want it.

Waveform Tools Manual 1-1



Waveform
Display Area

The waveform display area has a time scale on the top.
The horizontal scroll bar pans left and right in a
waveform. The vertical scroll bar displays additional
waveforms when there are more than can fit in the
window at one time.

Prompt Line The prompt line is below the bottom scroll bars. The
prompt line displays the following information:

Time The time corresponding to the Query Cursor, a solid
vertical line in the waveform display.

Level The digital level of the selected waveform at the
intersection with the Query Cursor. The selected
waveform is highlighted in the waveform name field.
Level takes the values supported by the simulator being
used—typically zero (0), one (1), or unknown (X). Bus
values are shown with the current radix.

Trig Indicates whether the current trigger conditions are True
or False. It appears on the prompt line only if triggers
have been defined.

Figure 1-1
Waveform Viewer Window

The Waveform Viewer
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Selecting the Waveforms to View
The most fundamental operation in the Waveform Viewer is adding
waveforms to the display. Once waveforms are displayed, they can be moved,
deleted, copied, and converted to bus format using the commands described in
the following sections.

Show

Waveforms are added to the display with the Show command from the Edit
menu. The Hierarchical Name List dialog box (Figure 1-2) that appears when
you select this command lets you choose a signal from any level in the
hierarchy, and combine two or more signals into a “bus” display.

Finding the Signal You Want

The large list box at the left and the control button above it simplify navigating
the hierarchy to find the signals you want. The list box initially displays the
top level of the hierarchy. Clicking the “Push” button displays the hierarchical
level (if any) below the top level.
To move to a lower hierarchical level, highlight that level in the list box, then
click the “Push” button. (If you are already at the lowest level, the button is
relabeled “Pop,” since you can only move upward in the hierarchy.) A display
line below the list box shows the full hierarchical path of the level you’re
currently on.

All signals at a given level are shown in the right list box. To add a signal to
the display, click on its name, then click the Add Wave button. (Or just
double-click on the signal’s name.) The signal is immediately added at the
bottom of the Waveform Viewer display.

Figure 1-2
Hierarchical Name List Dialog Box

The Waveform Viewer
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The waveform display can contain up to 256 waveforms. Use the vertical scroll
bar to select the waveforms to view.

Using the Probe Item Command

If there is a schematic for the design, the Probe Item command is the easiest
way to add waveforms to the display. Click on the desired net in the Hierarchy
Navigator, and the waveform for that net is added to the display. Buses from
the schematic can be probed, but the bus must be probed at the highest level at
which it exists in the hierarchy.

The Probe Item command is available only when the Waveform Viewer is
used with the Hierarchy Navigator.

Creating Multi-Signal “Buses”

You can create a “bus” display of two or more signals, whether or not they are
related. Highlight the first signal you want in the bus, then click on Add to
Bus. The signal is added to the edit box (at the top left). Continue adding
signals this way until the bus is arranged the way you want it. Then click on
the Show button to add the bus to the display.

To change your bus selections, click on the edit box. You can then manually
edit the list to delete or rearrange signals.

Duplicate

The Duplicate command copies waveforms. The original waveform remains in
the display. Duplicate is often used to add multiple copies of clock or other
control signals.

Move

You can move a waveform from one display location to another. Click on one
(or more) waveforms to highlight them. Then drag the names to the new
position and release the mouse button.

Hide

The Hide command from the Edit menu removes waveforms from the display.
The Undo command can be used to restore hidden waveforms.

Selecting the Bus-Value Radix

Bus values are displayed on the bus waveforms, and on the prompt line if a
bus is selected. You can change the bus radix using the Bus Radix command
from the Options menu. Click on the Binary, Octal, Decimal, or Hexadecimal
radio button in the dialog box that appears.

The Waveform Viewer
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Moving Around
Once the waveforms are displayed, there are several ways to manipulate the
waveform display area. The following sections briefly describe them.

View Commands

The View commands change the horizontal time dimension. Different time
segments of the displayed waveforms can be viewed.

Zoom In Increases the horizontal magnification each time it’s
executed. You see a shorter time segment in more detail.
You can also drag around any part of a waveform to view
it in more detail.

Zoom Out Reduces the current magnification each time it’s executed.
You see a longer time span with less detail.

Pan Slides the current viewing window across the waveforms.
The point you click on becomes the new center point of
the display. The magnification does not change.

Full Fit Clicking in the window fills the display with the full time
span of the displayed waveforms. Two options are then
available:

♦ Click at a location you want to see in more detail. This
returns the window to the previous magnification and
pans the view to the selected point.

♦ Drag the mouse to form a box around the area you
want to zoom in on. The magnification is adjusted to
display that area.

Scroll Bars

The horizontal scroll bar under the waveform display positions the time scale.
The vertical scroll bar controls the position within the set of visible waveforms.

Moving the Query Cursor

Several commands from the Jump menu move the query cursor.

Tick Left,
Tick Right

Move the cursor left and right by one small tick mark.
They are useful for slowly scanning a waveform, or for
accurately positioning the cursor at an event. The time
represented by one small tick mark changes as the scale is
changed with the View commands.

The Waveform Viewer
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10 Left,
10 Right

Move the query cursor to the left or right by one large tick
mark (equal to 10 small tick marks). The time represented
by a large tick mark changes as the scale is changed with
the View commands.

Time=0,
Time=End

Jumps to the beginning or end of the waveform.

To Marker Jumps to the current marker position.

To Time The display is centered on a time you specify.

Next Change Jumps to the next change in signal polarity.

Next Trigger Jumps to the next trigger point.

Jumping to Events

Events are logic-level changes. A change in any signal in a bus is considered an
event on that bus. Timing measurements are usually made between events.

Several commands in the Waveform Viewer make it easier to find events and
align the cursor to events. These commands are especially helpful when the
display is “zoomed out” and the resolution is too low to accurately position
the cursor.

The Jump: Next Change command moves the query cursor to the next event
on the selected waveform. It’s commonly used to measure the time difference
from one event to another.

1. Position the query cursor on the waveform with the first event, before the
first event.

2. Move the query cursor to the first event by selecting the Next Change
command. This positions the cursor exactly at the first event.

3. Execute the Place Mark command to set the marker at the first event.

4. Position the query cursor on the waveform containing the second event,
before the second event.

5. Move the cursor to the second event by selecting the Next Change
command. The time difference between the two events is displayed on the
prompt line.

This procedure works the same way with the Jump: Next Trigger command.

The Waveform Viewer
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Triggers

A trigger is an event that meets some specified criterion. The signal conditions
used to define a trigger in the Waveform Viewer are:

♦ High
♦ Low
♦ Unknown
♦ Change
♦ Positive Edge
♦ Negative Edge
♦ Bus = value

The Set Trigger command lets you apply any of the above conditions to one or
more waveforms. A trigger event occurs when all the conditions on all the
waveforms are met. You can locate a highly specific event by applying these
criteria to several waveforms.

The Next Trigger command advances the query cursor to the next defined
trigger event. If there is no trigger event, the cursor advances to the end of the
waveform display (Time=End).

Analysis Techniques
This section explains the waveform-analysis commands. You might find it
easier to use their accelerator keys than to select them from the menus.

Logic Level and Time Measurements

To measure logic levels and times on a waveform:

1. Select Options: Query. A query cursor appears on the screen. 

2. Click on the waveform you want to query. A vertical line passes through
the point you clicked on and the selected signal is highlighted in the name
field.

The prompt line displays the time and logic level at the cursor position. If
the selected signal is a bus, the logic levels of the bus signals are displayed
as a single numerical value in which each binary digit represents the logic
level of one of the bus signals.

The Waveform Viewer

Waveform Tools Manual 1-7



To measure the time difference between two events:

1. Move the query cursor to the first event.

2. Set the marker at this location with the Place Mark command.

3. Move the query cursor to the second event. The relative time between
these two events is shown on the prompt line under the heading ‘Delta’.

Interaction with the Hierarchy Navigator

The Find Item command from the Hierarchy Navigator locates the part of the
circuit driving a particular waveform. The Navigator automatically displays
the appropriate schematic. The net associated with the waveform is
highlighted.
This command is useful when you find an interesting event in the waveform
display and want to locate the source of the event on the schematic. The Find
Item command works only with the Hierarchy Navigator.

The Query command highlights the net associated with the currently selected
waveform. If the query window in the Hierarchy Navigator is already open, its
contents change to reflect the latest net queried with the Query command in
the Waveform Viewer.

The Probe Item command adds waveforms to the Waveform Viewer display
when you probe a net in the schematic.

Displaying Simulation Values on a Schematic

The logic values determined during simulation are displayed on the schematic
loaded in the Hierarchy Navigator. As the query cursor is clicked at different
points along the time line, the logic values on the schematic change to those for
that simulation time. All logic values are displayed and updated, not just those
for waveforms in Waveform Viewer’s display.
The logic values are displayed on the schematic in two ways:

♦ A small colored square is attached to any probed symbol nodes on the
schematic. The color of the square indicates the logic value. (The default
value is green for high, red for low. The colors can be changed with the INI
Editor.) These colored squares are useful when the schematic is displayed
at a low magnification and the text is too small to be read.

♦ Inside the small colored square is the text representation of the logic value.
The text value is 0, 1, X (unknown), Z (high impedance) or the value of a
bus.

The Waveform Viewer
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View Report

The View Report command reads error information from a file and displays
the errors interactively in a list box, one error to each line. Clicking left on a
line moves the waveform display to the corresponding error. If View Report is
used with the Hierarchy Navigator, the schematic is displayed and the pin
driving the net with the problem is highlighted.

Any third-party tool can be used to create the error file. Refer to Chapter 3,
“Command Reference,” for more details of the View Report command.

Saving and Printing Waveforms

Saving Waveforms

After completing a waveform analysis, you can save the Waveform Viewer
configuration using the Save and Save As commands. The information saved
consists of:

♦ Waveform names displayed
♦ Trigger conditions

Printing Waveforms

The Print command from the File menu prints the waveform display. A dialog
box (Figure 1-3) is displayed with the following controls:

Start Time Simulation time at which the plot is to begin.

Stop Time Simulation time at which the plot is to finish.

Figure 1-3
Print Waveforms Dialog Box
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Time Scale Scale of plot in nanoseconds/inch. Changing the time
scale changes the number of pages required to display the
waveform.

Sheets Number of sheets to plot the waveforms. The time scale is
automatically adjusted to fill the specified number of
sheets.

Names Width Waveform names are shown in a vertical strip along the
left hand edge of the page. This parameter determines the
width of this strip.

Names on Sheets The Names strip is printed on every page if the Names On
All Sheets check box is marked. Otherwise only the first
sheet displays the names of waveforms, and there is more
display space on the following sheets.

Portrait Displays the time axis along the short edge of the paper.

Landscape Displays the time axis along the long edge of the paper.
This is the default.

Print Sends the plot to the printer, using the current settings.

If you decide not to print, double-click on the System button at the upper-left
corner of the dialog box to close the box.

Waveform Viewer Configuration
The Waveform Viewer has several configuration variables. These variables are
modified using the Wave Controls and Wave Colors dialog box from the
Controls menu of the INI Editor. If you are using Synario or SCS, you can see
“The SCS INI Editor” in the SCS User Manual for a complete explanation of
these variables.  You can also set up a state table for viewing waveforms as
explained in "Exporting the Stimulus File" in Chapter 2, "The Waveform
Editor."

The Waveform Viewer
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Chapter 2

The Waveform Editor
The Waveform Editor for Synario and SCS lets you create the stimulus
graphically, by clicking and dragging with the mouse. You see exactly what
each waveform will look like, as well as its timing relationship to all the other
waveforms.

The Waveform Editor can be used as a stand-alone tool or interactively with
the Hierarchy Navigator. Running the Waveform Editor with the Hierarchy
Navigator offers a number of advantages, including direct entry of node
names and the direct display of stimulus logic levels on the schematic.

This chapter contains the following sections:

♦ Running the Waveform Editor
♦ Creating Test Stimulus
♦ Displaying the Waveform Names
♦ Drawing the Waveforms
♦ Exporting the Stimulus File
♦ Waveform Editor Configuration

Many Waveform Editor commands are similar to those of the Waveform
Viewer, so the Waveform Editor and Viewer commands have been combined
in Chapter 3, “Command Reference.”  Configuration of the Waveform Editor
is explained in the “Waveform Editor Configuration” section at the end of this
chapter.

Running the Waveform Editor
You can run the Waveform Editor by itself, or from within the Hierarchy
Navigator.  You can also run it in Synchronous mode, described below.  The
information in this chapter assumes you have launched Waveform Editor from
the Navigator.
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Running the Waveform Editor Stand-alone

To run the Waveform Editor by itself, click on its icon in the SCS program
group. You can also use the Run command from the File menu of the Program
Manager. Using the Run command lets you add the name of an existing
Waveform Editor (.wdl) file to the command line. This file will automatically
be loaded. Under UNIX, you can start wet.exe directly from the command line.

Running the Waveform Editor from the Hierarchy Navigator

Running the Waveform Editor from the Hierarchy Navigator offers several
advantages, including automatic listing of all the input and output nodes of
your design. 

To run the Waveform Editor from the Hierarchy Navigator:

From Synario

Click the Navigate Hierarchy process.

From SCS 

1. Click the Navigate Hierarchy radio button in the SCS Executive.  

2. Highlight the .tre file for your project, then click RUN (or double-click on
the name of the file).  If the Navigator is already running, use the Open
command from the File menu to load the .tre file for your project.

3. Select the Waveform Editor command from the Simulate menu. The
Waveform Editor is launched.

If the Waveform Editor finds a .wdl file in the current directory with the
same base name as the current project, it will automatically load and
display the waveforms in that file. The Waveform Editor window is shown
in Figure 2-1.

Running the Waveform Editor in Synchronous mode

Running the Waveform Editor in Synchronous mode allows you to
synchronize signals in order to export the waveform descriptions to automatic
test equipment.  Usually, normal mode is sufficient.

To run the Waveform Editor in Synchronous Mode:

From the command line, specify the -sync option.

Refer to "Changing the Waveforms for Exporting" later in this chapter.

The Waveform Editor
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Creating Test Stimulus
Once you’ve completed your design (or a module of the design), you’ll want to
test it to confirm that it behaves the way you expect it to. Simulation requires a
test stimulus file that specifies the input waveforms.

There are three basic steps in creating a stimulus file with the Waveform
Editor:

1. Select the signals you want to define stimuli for.

2. Draw the stimulus for each input.

3. Export the waveform information to a stimulus file.

Each of these steps is covered in a section of this chapter. 

Note: If you are using the Project Navigator, the Waveform Export step is performed
automatically.

Figure 2-1
Waveform Editor Main Window

The Waveform Editor
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Displaying the Waveform Names
Before you can create the stimulus waveforms, you must first display the
names of the I/O markers the stimuli will be applied to. If you launch the
Waveform Editor from the Hierarchy Navigator, the Navigator passes the
names of all the design’s inputs and outputs (and their polarities) to the
Waveform Editor. If you run the Waveform Editor by itself, you must enter the
names manually.

Running from the Hierarchy Navigator

To display the names you want, select the Show command from the Edit
menu. The Show Patterns dialog box is displayed, as shown in Figure 2-2.

By default, all inputs, outputs, test points, reference, and global signals are
listed. You can narrow the list by clearing one or more of the five check boxes
to the left of the list.  If you are creating only input stimuli, you would
probably check only the Input and Bidir check boxes.  Test point signals are
intermediate signals that do not directly connect to a primary input or output
of the circuit.  Reference signals can be displayed but not edited, and are
created by display commands such as Expand Bus.

Figure 2-2
Show Patterns Dialog Box for Selecting Net Signals to Display

The Waveform Editor
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To add waveforms to the display:

Click on any name, then the Show button, to add the name to the display. You
can also select more than one name at time:

♦ Click on a name and drag the mouse to select names above or below. Or
♦ Click on a name, then hold down SHIFT and click on a second name to

select all the names between. Or
♦ Hold down CTRL and click to select (or deselect) individual names.

In the display, a letter next to the name indicates its type: I for input, O for
output, T for test point, and so on.

You can also add a net or bus name by clicking on it in the Hierarchy
Navigator. This is explained in a following section, “Adding Test Points.”

Running Stand-Alone

When the Waveform Editor runs by itself, you must enter the signal names
manually.

1. Select the New Wave command from the Edit menu. The Add New Wave
dialog box is displayed (Figure 2-3).

2. Choose the type or polarity.

3. Click within the edit box and enter the name you want.

4. Press ENTER or click Add to add the name to the name window.

You can now define the waveform for this name. The Add New Wave dialog
box remains open so you can continue to add names.

CAUTION: In a hierarchical design, the names can include hierarchical
information, such as (t(ACTIV or (t(CLOCK(SYSCLK. Any name you enter
must include the full hierarchical path for that name. If it does not, the
simulator will not be able to apply the stimulus. It is easier to run the
Waveform Editor from the Hierarchy Navigator and let the Navigator provide
the list of names.

Figure 2-3
Add New Wave Dialog Box

The Waveform Editor
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CAUTION: There is no warning if you neglect to add an input node to the list.
Before running the simulator, be sure you have defined all inputs (and other
nodes) that need to be defined.

Adding Test Points

You can also add internal nodes (that is, nets that do not have external
connections or I/O markers) to the name window. These internal nodes are
called Test Points.
One way to add them is with the Add New Wave dialog box, as described in
the preceding selection. Click on the Test Point radio button before you enter
the name. (If the names for the I/O markers include hierarchical information,
you must also include this information for a Test Point.)

To add a Test Point in the Hierarchy Navigator:

1. Select the Probe Item command from the Tools menu of the Hierarchy
Navigator.

2. Click on the internal node you want to add to the name list.

3. A dialog box displays the node name and prompts you to add this
“Undefined Pattern” to the list. Click Yes to add it.

You can also add inputs or outputs this way by clicking on them. They are
added directly to the name list, without the dialog box prompt. When you add
inputs or nodes by clicking in the Hierarchy Navigator, the Waveform Editor
switches to Query mode. (You will see the letter Q added to the cursor.)

Using Test Points

Test points can be used to “force” internal nodes to specific values during the
simulation. However, not all simulators support this function. Check your
simulator’s documentation to see if you can define arbitrary values for internal
nodes.

Hiding and Restoring Waveforms

If you decide you don’t want to display a particular name (and its waveform),
you can temporarily hide it from the main window.

To hide a waveform:

1. Click on the name to select it. The name is highlighted with gray diagonal
lines.  To select more than one name in the main window, click on a name
that is not highlighted. Then drag the mouse to select names above or
below the first name. 

The Waveform Editor

2-6 Waveform Tools Manual



2. Select the Hide command from the Edit menu.  The Hide command
removes all the highlighted names and their waveforms.

To deselect all the currently selected names, click in the waveform section
of the main window anywhere below the waveforms.

Hiding the name and its waveform does not remove it from the Waveform
Editor database. You can restore it at any time with the Show command. 

To show a hidden waveform:

1. Select the Show command.

2. Click on the name you want to show.

3. Click the Show button.

To remove a waveform from the display and the internal database:

1. Select the Remove command. The Remove Patterns dialog box is
displayed (see Figure 2-4).

2. Click on the name you want to remove.

3. Click the Remove button.

Note: You cannot delete a Pattern if the Pattern is currently inserted in one of the
waveforms. The Remove button is disabled.

Figure 2-4
Remove Pattern Dialog Box

The Waveform Editor
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Drawing the Waveforms

Edit and Query Modes

The Waveform Editor has two operating modes, Edit and Query. Edit is the
default mode. The Query mode is used when you cross probe with the
Hierarchy Navigator, and when you view time and logic values in the
Waveform Editor.

Before you can draw or modify waveforms, the Waveform Editor must be in
Edit mode. You can tell which mode is active by looking at the cursor. The Edit
cursor is a “squiggly” vertical line. The Query cursor is the same curved line
with the letter Q next to it.

To change modes:

Select Edit Mode or Query Mode from the Object menu. When you switch to
Edit mode, the Toolbox is displayed (if it was not previously displayed). The
Toolbox is explained later in this section.

Simulation Timing Values

Before drawing the waveforms, you may need to enter timing information for
the simulation. This is done through the Setup Options command from the
Options menu. A full description of the process appears in the “Waveform
Editor Configuration” section of this chapter.

The Waveform Editor
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Creating Waveforms

You draw waveforms in the right hand side of the main window. 

A special dialog box, the Toolbox (shown in Figure 2-5 in "Editing
Waveforms"), lets you edit the waveform to get it exactly the way you want it.
The Toolbox is always displayed in Edit mode, unless you explicitly close it.

To create a waveform:

1. Be sure you are in Edit mode. If you are in Edit mode, but the Toolbox is
not displayed, select the Edit Mode command from the Object menu.

2. Click on the name you want to create a waveform for. The name is
highlighted with light gray diagonal lines.

3. Move the mouse to the waveform section of the window and click where
you want the first Transition. (You must click in the area next to the
highlighted name.) A line is drawn showing the first section (called a
Pulse) of the waveform.

4. Click again to create the second Transition. The Pulse drawn has the
opposite state of the first Pulse.

5. Continue clicking to complete the waveform.

Note: The View commands (described in detail in Chapter 3, “Command Reference”)
allow you to zoom in and zoom out on the waveforms, to view them in more or less
detail. If you zoom out so far that the Waveform Editor cannot display the Transitions
of the waveform, the waveform is replaced with a “hatching” of diagonal lines to warn
you. Use the Zoom In command to switch to a higher magnification.

Editing Waveforms with the Toolbox

The Toolbox (shown in Figure 2-5) gives you complete control over the state
and duration of each Pulse.  Creating or editing waveforms with the toolbox
allows you to be more precise. The state is shown in the States edit box, the
duration in the Duration edit box.

Setting Duration and the Master Clock Time

If you are running the Waveform Editor in Synchronous mode and the Master
Clock Time is applied to a particular pulse, any Duration you enter is forced to
the next lowest integral multiple of the Master Clock Time. For example, if the
Master Clock Time is 0.02 ns, and you enter a value of 0.037 ns, the entered
value is truncated to 0.030 ns.

The Waveform Editor
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Selecting Pulses

Click anywhere within a Pulse to select it. The Pulse is marked with thick black
lines above and below it. 

The values of the Pulse’s parameters are displayed in the Toolbox. (Each Pulse
you create is automatically selected until you create another Pulse or select a
different Pulse.)

A single click selects a single Pulse. Successive clicks on the same Pulse select
more and more of the waveform. If the waveform consists of nothing but
Pulses (that is, it contains no Patterns) a second click selects the entire
waveform. If the Pulse is within a Pattern, the second click selects the full
Pattern. This “hierarchical” selection process is repeated with each click, until
the entire waveform is selected.

Setting State and Duration

To change the state of a pulse:

♦ Click on the desired state in the States list box, Or...
♦ Press TAB to move the focus to the States box, then press the UP or

DOWN arrows to select a state, Or...
♦ Enter the state in the Value edit box.

Changing a Pulse from Low to High or High to Low effectively removes it
from the waveform, since it now has the same value as the Pulses on either
side.

To change the duration of a pulse:

Click in the Duration edit box and enter a time. 

Figure 2-5
Waveform Editor Toolbox
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Bus Pulses

Bus waveform pulses are shown as elongated hexagons. (See the (t(REF[7:0]
waveform in Figure 2-1.) Bus pulses can have any value that can be
represented by the number of bits in the bus. For example, any pulse in an
eight-bit bus waveform can be assigned a value between 0 and 255.

Bus pulses are given default values, in sequential order: 0, 1, 2, 3, and so on.
You can change any of these values at any time. Click on the bus pulse to
which you want to assign a new value, then enter the new value in the Value
edit box.

The format for bus value display and entry is set in the Display Options dialog
box from the Options menu. If the number you entered is not displayed
correctly, be sure you are entering it in the currently-selected Bus Radix format.

Selecting Spans

You are not limited to selecting discrete Pulses or groups of Pulses. You can
also select any arbitrary section of the waveform, called a Span, by dragging
the cursor across the waveform. There are, however, limitations to this
selection mode:
♦ The selected Span must fall completely outside a pattern, or completely

within a Pattern. It cannot be a mixture of Pattern and non-Pattern.
♦ You must drag the cursor across at least one Transition. If you drag only

within a Pulse, you will alter the duration or starting time of Pulse. (This
editing method is explained later.)

Graphically Changing the Length of a Pulse

To change the length of a Pulse graphically:

1. Click on the Pulse you want to lengthen or shorten.

2. Click on the Pulse a second time and hold the mouse button down. The
black bars around the Pulse change to dotted lines.

3. Drag the mouse left or right to change the length of the Pulse.

♦ If you select the last Pulse in a waveform, dragging changes the length
of that Pulse and extends the waveform.

♦ If you select a Pulse within the waveform, dragging alters the start time
of the Transition at the beginning of that Pulse. The preceding Pulse is
lengthened and the selected pulse shortened (or vice versa). The total
length of both pulses (and of the complete waveform) does not change.

The Waveform Editor
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♦ If you press and hold SHIFT before you click on a Pulse, dragging
changes the length of the Pulse. Any Pulses to the right of the selected
Pulse are moved (without modification) to accommodate the length-
ened or shortened Pulse. Use this mode to adjust a Pulse without chang-
ing anything else in the waveform.

Remember that Pulses always have a length that is an integral multiple of
the Time Units selected in the Setup Options dialog box.

Changing the Offset of a Waveform

You can drag a waveform to the right to add an offset at the beginning of the
waveform.

1. Click on the waveform as many times as necessary to select the entire
waveform.

2. Press and hold the SHIFT key.

3. Click on the waveform and drag it to the right. A logic low region, shown
in dotted lines, is added at the beginning of the waveform.

4. Release the mouse button when the offset is the length you want.

This added offset region delays the start of the waveform. This new region is
not a Pulse and cannot be selected or edited. To remove it or change its length,
repeat steps 1 through 4 above. You can also change the length of the offset by
editing the Offset value for this waveform in the Node Parameters dialog box.

You cannot add an offset at the beginning of a Pattern.

Creating and Using Patterns

You may find yourself drawing the same waveform over and over again. The
Waveform Editor allows you to name and define arbitrary waveforms, called
Patterns, which you can then add to or insert in any other waveform.  When
you edit the pattern waveform, all waveforms that use that pattern change.

Patterns normally represent single-bit data. You can create a bus Pattern by
adding a bit range to the name, as shown below:

$buspat[7:0]

Bus Patterns cannot be added to single-bit waveforms, or vice versa. Also, the
number of bits in a bus Pattern must match the number of bits in the bus
waveform to which it is added.

The Waveform Editor
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To create a pattern:

1. Select the New Wave command from the Edit menu. The Add New Wave
dialog box is displayed (Figure 2-3 on page 2-5).

2. Click the Pattern radio button.

3. Type a name for the Pattern in the edit box. The name should begin with a
dollar sign ( $ ). If you don’t include a dollar sign, the Waveform Editor
automatically adds one.

4. Click on Add (or press ENTER) to add the Pattern’s name to the name list.
The dialog box remains open, so you can continue to add Pattern names
without having to reselect the command.

You can now draw a waveform for your Pattern, as you did for the names.
Once the Pattern is drawn, you can add it to a waveform or another pattern.

To add a pattern to a waveform or another pattern:

1. Click on the Transition where you want to insert the Pattern. Or, click on
the Pulse you want the Pattern to replace.

2. Select the Insert Pattern command from the Edit menu. The Patterns
dialog box is displayed.

3. In the list box, click on the name of the Pattern you want to use.

4. Click on Insert to insert it.

Note: You can also use the Copy command to copy a Pattern to the Clipboard, then
use the Paste command to insert it in another waveform. The Pattern, however, is
inserted only as a series of Pulses, and loses its identity as a Pattern.

Hierarchical Patterns

Patterns can be defined hierarchically. That is, one Pattern can contain other
Patterns, which themselves include other Patterns, and so on. This feature
makes it possible to build complex Patterns from simpler “building block”
Patterns.

Note: Hierarchical Patterns cannot be defined recursively. That is, you cannot add a
copy of a Pattern to itself.

The Waveform Editor
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Editing Patterns

You edit patterns the same way as waveforms. When you change a Pattern, all
the waveforms containing it change.

You can edit either the Pattern itself, or an instance of that Pattern in another
waveform (“in-place” editing). If you edit the instance, the original pattern is
also modified. All changes are shown immediately on the screen.

Note: You can do “in-place” editing only if the waveform of the Pattern is displayed
(rather than a rectangle). The Waves checkbox in the Display Options dialog box must
be marked (or the Names checkbox must be unmarked).

Adding Pulses

You may sometimes decide that a single pulse should be divided into two
shorter pulses. Or, perhaps you need to add a pulse to a section of the
waveform that is currently at logic level 0.

To add a pulse:

Click and drag the mouse within the Pulse. (Don’t drag the mouse over the
Transitions at either end.) The dragged region is converted to the opposite
polarity.
♦ If the pulse was originally high, the dragged area will go low and the

original pulse will become two pulses.
♦ If the pulse was low, the dragged area will go high and a new pulse will be

added.

In either case, the total length of the waveform is not changed. The dragged
section remains selected, and you can modify its length or starting time as
required.

Scaling Patterns and Waveforms

To make any pattern, span, or an entire waveform lo nger by scaling it:

1. Select the pattern, span, or waveform you want to scale.

2. Click the Scale edit box in the Toolbox.

3. Enter any whole number larger than 1. The length of the selection will be
multiplied by this value. (A span is multiplied only if it is not part of a
Repeat Forever waveform.)

4. Press ENTER to see the change.

The Waveform Editor
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If a complete waveform contains a pattern, that pattern is scaled along with the
rest of the waveform. (The original definition of the pattern is unaffected by
the scaling.)

Repeating Patterns and Waveforms

To repeat any pattern or an entire waveform.

1. Select the pattern or waveform you want to repeat. You can also drag to
select any arbitrary section of a waveform (except sections that are part
pulse, part pattern).

2. Click the Repeat edit box in the Toolbox.

3. Enter any whole number larger than 1 for the number of times you want
the pattern, waveform, or selection repeated.

4. If you want a waveform to be repeated indefinitely, mark the Forever
check box. You can only repeat forever selections and pulses at the end of
a waveform.  Patterns and selections cannot be repeated indefinitely. The
Forever check box is disabled for these items.

5. Press ENTER to see the change.

Deleting, Cutting, Copying, and Pasting

Any part of a waveform that can be selected (pulses, spans, or the entire
waveform) can be deleted, or cut or copied to the clipboard.

To delete, cut, or copy part of a waveform:

1. Select the part of the waveform you want to delete or copy.

2. Select the Delete command from the Edit menu to remove the selected
region. The deleted data is not copied to the Clipboard. 

Or

Select either the Cut or Copy command from the Edit menu. The Cut
command deletes the region and copies it to the Clipboard. The Copy
command copies it to the Clipboard without deleting it.

To paste the copied data into the current waveform:

1. Select the point where you wish to paste the data. If you select a
Transition, the data is inserted at that point. If you select a Pulse or Span,
the data replaces the selection.

2. Select the Paste command from the Edit menu.

The Waveform Editor
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Changing the Display Options

The Display Options dialog box from the Options menu lets you control the
appearance of the waveform display.

♦ When the Guidelines box is checked, the waveforms are drawn with
dotted lines separating them. These lines make it easier to see which
waveform you are about to select before you click.

♦ The Names and Waves boxes control the display of Patterns. When only
the Names box is checked, Patterns are displayed as featureless boxes with
their names written inside. Clicking on a Pattern selects the entire Pattern,
not just one of its Pulses.

When both the Names and Waves boxes are checked, the Pattern’s
waveform is also displayed within the box. You can select any Pulse in a
Pattern by clicking on it.

When neither the Names or Waves box is checked, Patterns are displayed
simply as waveforms, without any box or name to indicate they are
Patterns.

You cannot check only the Waves box. The Names box must be checked
before the Waves box can be marked.

♦ When the Synchronous Activity box is checked, the waveform
modifications produced by changing the Synchronous Activity are
displayed. (Synchronous activity is explained in a later section, “Changing
the Waveforms for Exporting.”)

Saving Changes

The first time you use the Save command from the File menu, the Waveform
Editor creates two files, project.wet and project.wdl. The .wet file contains the
names of the nodes or signals you have created waveforms for. The .wdl file
contains the waveforms themselves, in WDL (waveform description language)
format. (The WDL format is described in Appendix A.) You can use the Save
As command to save files under a different base name, to create multiple
stimulus files for a single project.

CAUTION: You can perform an unlimited number of Undos and Redos until
you save the file. At that point, the files are updated and all Undo/Redo
information is lost. Don’t save the file if there are still changes you want to
Undo or Redo.

The Waveform Editor
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Viewing Logic Values on the Schematic

If you are running the Waveform Editor from the Hierarchy Navigator, the
waveforms’ logic values are displayed on the schematic, both as 0s and 1s, and
as changes in node color. You do not have to select a specific waveform. All
the waveform values are displayed on the schematic.
Switch to Query mode and click on the time line to see the logic values for that
time. Or press the LEFT and RIGHT arrow keys to move the cursor through
the waveforms. Or use the Jump: To Time command (Figure 2-6) to select a
specific time.

Exporting the Stimulus File
After you have created your waveforms, you create a stimulus file for
simulation.  The Waveform Editor database is translated into the stimulus
format of the target simulator and written to the appropriate files.   You do not
need to export the stimulus if you’re using the Project Navigator, since it is
does automatically.

To export to a stimulus file:

♦ Select Export from the File menu. 
♦ You can also create the stimulus file automatically each time you save your

work by marking the Export on Save check box in the Setup Options
dialog box.

Stimulus File Format

The stimulus format is determined by the target simulator. The simulator must
be specified in the INI file (as described in the SCS User Manual) so that the
Waveform Editor knows which simulator.ini file to read to obtain the correct
conversion and formatting instructions.  

Figure 2-6
Jump to Time Dialog Box
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Setting the [Export] Section for a Simulator

The simulator.ini file must also contain an [Export] section. If there is no
[Export] section in the simulator.ini file, the Export command in the File menu
is disabled and you will not be able to export a stimulus file. This section
includes the command line for the export conversion program (exp.exe):

exp options

where options include one or more of the following:

Option Effect

-help Displays this listing of options
-hilo HILO simulator format (Genrad)
-silos SILOS simulator format (Simucad)
-xsim XSIM simulator format (.sas)
-global Include Global nodes in export
-testpt Include Test Point nodes in export
-verilog Verilog format (.tf)
-out=filename Output file has the base name filename

-ext=.abc Output file has the extension .abc

The default output filename is the base name of the design with the extension
for the simulator you are using. You can override the base name with the -out
option and the extension with the -ext option.

The [Export] section contains the instructions that tell the Waveform Editor
how to convert the waveforms you have created into a stimulus file in the
correct format for the target simulator.

Changing the Waveforms for Exporting

You can change the waveforms for exporting using the Synchronous mode of
the Waveform Editor. The direct conversion of the waveforms to the
appropriate stimulus file format is usually all you need. However, if you are
creating simulation data for use with ATE (automatic test equipment), you
may need to adjust the timing of the stimulus data written to the test file.

The most common modifications involve changing Pulse timing. Test stimuli
are usually entered with synchronized Transitions (that is, all signals change
state at the same time), and this does not usually happen in the actual circuit.
You can simulate your design more accurately if some variability and delay is
introduced into the timing. Use Node Parameters to alter the signal timing.
You can also change signal strength by associating a state table with each
waveform (explained in a later section).
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2-18 Waveform Tools Manual



To change the node parameters:

Select the Node Parameters command from the Edit menu.  The Waveform
Editor displays the dialog box shown in Figure 2-7:

Note: The Type and Cycle sections are only available when running the Waveform
Editor in synchronous mode.

Before you can modify a node, you must highlight its name in the Nodes list
box. 

To select a node or nodes:

♦ Drag the cursor across two or more names.

Or...

♦ Select one name in the Node Parameters dialog box, then press SHIFT
while selecting a second name. The range of names between is highlighted.

Or...

♦ Hold down CTRL, then click in the Node Parameters dialog box to select
(or deselect) individual names.

When more than one node is selected, any changes you make apply to all
selected nodes.

Figure 2-7
Node Parameters Dialog Box
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Changing Polarity

The Polarity radio buttons let you change the signal polarity of a node in the
stimulus file. (The schematic is not altered.) This feature is most often used to
change BiDir nodes to Input nodes. Most simulators do not accept stimulus
data for Bidirectional nodes, which must be redefined as Inputs.

To change the polarity of node:

1. Select Edit: Node Parameters

2. Highlight the node in the Nodes list box. 

3. Click the radio button for the desired Polarity.

Changing Offset

The Offset edit box lets you retard every Transition in a waveform by the
amount of time entered. In this way, all the Transitions in the waveforms do
not occur at exactly the same time. Only positive values (delays) can be
entered.

You generally apply Offsets only to selected waveforms. If you offset all of the
waveforms in the stimulus set, you have no net offset.

Synchronous Mode Options

Changing Type

The Type radio buttons in Synchronous mode allow you to further modify the
Transitions in a waveform. The default Type is Async (asynchronous), that is,
Transitions occur wherever you have set them.
When you select a Type other than Async, you can then use the "Cycle" and
"Active For" settings to add additional Transitions to a waveform. These
Transitions are timed with respect to the Master Clock. 

The functions of the Type radio buttons are outlined below:
♦ The Cycle setting is a multiplier for the Master Clock time. Its default

value is 1, but you can select any positive integer value. (If you enter a
value containing a fraction, the value is truncated to the next smallest
integer >= 1.) The resulting net Master Clock cycle time is the Master
Clock time defined in the Setup Options dialog box multiplied by the
Cycle value.

♦ The Active For setting is entered as a percentage. The new Transitions in
each Master Clock cycle occur after the percentage of Master Clock cycle
time specified here has elapsed.
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You can enter any percentage value. However, the percentage actually
used (as shown by the time value to the right of the Active For edit box) is
rounded off to the nearest fractional part of the Cycle setting.

For example, if Cycle is 2, you can only have percentages of 0, 50, and 100.
If Cycle is 4, you can have percentages of 0, 25, 50, 75, and 100. If (in the
last case), you entered an Active For value of 70, the actual time value
shown (and used) will be rounded up to 75% of the net Master Clock Cycle
Time.

♦ The Type setting determines the type of Transition added. There are five
types.

Type Effect

Async The default setting. Transitions and Pulses occur without
modification.

NRZ “Non-Return to Zero”— If the waveform is high, it
remains high. If low, it remains low. This is equivalent to
Async, except the Cycle factor can be used.

RZ “Return to Zero”— If the waveform is high, it changes to
low. If low, it remains low.

R1 “Return to One”— If the waveform is high, it remains
high. If low, it changes to high.

RC “Return to Complement”— The waveform changes to the
opposite polarity.

Any changes begin after the Active For percentage of each net Master Clock
time interval, and remain until the beginning of the next Master Clock time
interval. At that time, the waveform returns to the value defined in the
stimulus file.

If the Assign to All Nodes box in the Setup Options dialog box is checked, the
Master Clock timing is automatically applied to all nodes. You can use MC_On
and MC_Off radio buttons in the Node Parameters dialog box to override the
default setting for a particular node.

Example

This example assumes the Master Clock is set to 0.02 ns, the Cycle to 2, Active
For to 30, and the Type to RZ, then:

♦ The net Master Clock Cycle Time is 0.04 ns.
♦ Since Cycle is 2, the actual Active For percentage is rounded up from 30%

to 50%.
♦ The Active For time interval then becomes (0.04 x 50%), or 0.02 ns.
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Suppose that a waveform is high at the beginning of a Master Clock Cycle.
Since the Type is RZ (Return to Zero), after 0.02 ns the value will go low and
remain there for the rest of the cycle. At the start of the next cycle, the
waveform will have whatever value is defined in the stimulus file for that time.

Figure 2-8 shows how the waveform at the top can be modified by a variety of
Type settings and percentages.

Note: The Master Clock Cycle Time (as modified by the Cycle multiplier) sets the
minimum time increment for modifying the waveform or selecting parts of the
waveform. For example, if the net Master Clock Cycle Time is 0.2 µs, a Pulse added to
the end of a waveform cannot be any shorter than 0.2 µs, and must be an integral
multiple of that value. Any Span selected must be at least 0.2 µs long (or some whole
multiple of that value). If you drag within a Pulse to create new Pulses, the time
selected can only be a multiple of 0.2 µs.

Selecting a State Table

Most logic simulators represent the stimuli with both a logic state and a
strength. The strength indicates how resistant a signal’s state is to change. A
strong signal (such as a power supply) is unlikely to be influenced by other
signals. A weak signal (such as that on a tristate bus) is easily forced to another
state.

A state table maps states and strengths used by the Waveform Editor to target
simulator states and strengths. The State Table section of the Node Parameters
dialog box specifies the state table used for each waveform. By creating a
different state table for each simulator, you can use one set of waveforms with
more than one simulator.
A typical logic simulator has three states: High, Low, and Unknown. Typical
simulator strengths are Supply, Driving, Resistive, and High Impedance. This
represents a total of 12 combinations. The Waveform Editor can represent
signals as any combination of 16 states and 16 strengths, for a total of 256
state-strength combinations. Most simulators require far fewer combinations.

The State Tables list box in the Node Parameters dialog box shows the
available state tables. 

To change the state table for a waveform:

1. Select one or more waveforms from the Node list box.

2. Click on the name of the state table you want.

The Default state table is built into the Waveform Editor. All other state tables
are defined in the simulator.ini file.
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Figure 2-8
Modifying Waveforms with the Pin Type Settings
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Creating State Tables

State tables are defined in the [StateTables] section of the simulator.ini file. You
can define as many state tables as you want. The following example shows
three state tables named CMOS, NMOS, and TTL.

[StateTables]

   CMOS
   0 = 0, 4, ’0’, "Low"     , "S0"
   1 = 1, 4, ’1’, "High"    , "D1"
   2 = 2, 1, ’X’, "Unknown" , "X0"
   3 = 3, 2, ’A’, "CMOS-3"  , "V3"
   4 = 3, 2, ’B’, "CMOS-4"  , "V4"

   NMOS
   0 = 0, 4, ’0’, "Signal"  , "S0"
   1 = 1, 4, ’1’, "Signal"  , "D1"
   2 = 2, 1, ’X’, "Unknown" , "X0"
   3 = 3, 2, ’A’, "NMOS-3"  , "V3"
   4 = 3, 2, ’B’, "NMOS-4"  , "V4"

   TTL
   0 = 1, 4, ’0’, "Signal"  , "S0"
   1 = 0, 4, ’1’, "Signal"  , "D1"
   2 = 2, 1, ’X’, "Unknown" , "X0"
   3 = 3, 2, ’A’, "TTL-3"   , "V3"
   4 = 3, 2, ’B’, "TTL-4"   , "V4"

The name of each group is the name that appears in the State Tables list box of
the Node Parameters dialog box. The number to the left of the equals sign ( = )
is an index into the state table. Up to 16 states numbered 0–15 can be defined
for each state table. 
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The values to the right of the equals sign define the characteristics of each
state. These (from left to right) are Level, Color, NavChar, AsciiString, and
SimText. These are explained below.

Level Graphic level 0: low, 1: high, 2: unknown, 3:
high-impedance

Color The color of the schematic node in the Hierarchy
Navigator. The node changes color to represent the logic
level. Sixteen colors are available, numbered 0–15:

0 White
1 Cyan
2 Magenta
3 Blue
4 Yellow
5 Green
6 Red
7 Dark Gray
8 Light Gray
9 Dark Cyan
10 Dark Magenta
11 Dark Blue
12 Dark Yellow
13 Dark Green
14 Dark Red
15 Black

NavChar The character displayed on the schematic node in the
Hierarchy Navigator. The character represents the logic
level. 0, 1, and X are most often used, but you could use L,
H, and U. You can enter more than one character (such as
Lo and Hi), but only the first character is displayed.

AsciiString Used for prompts.

SimText This text is sent to the target simulator to specify the
stimulus.
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Waveform Editor Configuration
A number of steps must be performed before the Waveform Editor and your
simulator can be used with the SCS. The following sections explain these steps.

Simulator Setup

The Waveform Editor uses the specifications in the [Export] section of the
simulator initialization file (simulator.ini) to define the exported waveforms’
file format. For more information on the simulator initialization file, see
“Simulator Interfaces” in the SCS User Manual.

System Parameters

The same system parameters that control the color and spacing of waveforms,
background color, waveform strength (and so on) for the Waveform Viewer
control the same characteristics of the Waveform Editor. You can set these with
the INI Editor. (See “The SCS INI Editor” in the SCS User Manual.)

The following parameters are specific to the Waveform Editor. They can be set
for the current session in the Setup Options dialog box (Figure 2-9). The INI
Editor does not currently support these parameters, so you must modify the
ecs.ini file with a text editor to make the changes permanent. Once you have
added or changed these entries, the INI Editor will not modify or overwrite
them.

WETEndTime Sets the length of the simulation. The length is the time
unit specified by BasicUnit multiplied by WETEndTime. If
not specified, the default is 1,000,000. You can override the
default setting for the current session with the Simulation
Time edit box in the Setup Options dialog box.

BasicUnit The negative logarithm of the base time unit. For example,
BasicUnit=12 defines the base time unit as 1 picosecond.
All time units in the database must be multiplied by the
base time unit to obtain the actual time. If not specified,
the default is 9 (1 nanosecond). You can override the
default setting for the current session with the Time Units
edit box in the Setup Options dialog box.

ClockMult Default value for Master Clock Cycle Time, in integral
multiples of the BasicUnit. If not specified, the default is 1.
You can override the default setting for the current session
with the Master Clock Time edit box in the Setup Options
dialog box.
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AutoClockAssign Determines whether signals have the Master Clock Cycle
Time applied automatically. The default value is Yes. You
can override the default value (either Yes or No) of
AutoClockAssign for the current session with the Assign
to All Nodes check box in the Setup Options dialog box.
You can override the default setting (either Yes or No) for
a specific signal in the Node Parameters dialog box.

AutoExport Determines the default value for the AutoExport switch in
the Setup Options dialog box. If set to Yes, an export
occurs automatically every time the Save command is
executed. You can override the default setting for the
current session with the Export On Save check box in the
Setup Options dialog box.

Simulation Timing Values

Before drawing the waveforms, you may need to enter timing information for
the simulation. Select the Setup Options command from the Options menu.
The dialog box shown in Figure 2-9 is displayed.

Note: The Master Clock Time and Assign to All Nodes options are available only in
Synchronous mode.

Time Units

The Time Units radio buttons select the time interval for the simulation
database. In the simulation stimulus file, stimulus values are specified at
intervals of this Time Unit.

Figure 2-9
Setup Options Dialog Box
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All stimulus events occur at, and have lengths of, integral multiples of the
Time Units. This feature makes it easier to draw waveforms (as explained
below), because all Transitions are automatically forced to occur at multiples
of the Time Units.

Simulation Time

The Simulation Time is the total run time for the simulation. The default value
is 1,000,000 times the Times Unit value. For example, if the Time Unit selected
is 0.01 ns, the default value in the Simulation Time edit box is 10,000.0 ns. You
can change the Simulation Time by clicking on the edit box and typing the
value you want.

Note: A long Simulation Time combined with short Time Units may require an
excessive amount of computer time. Be sure you have selected values appropriate for
your design before you begin simulation.

Master Clock Time

The Master Clock Time sets the simulation’s resolution. That is, the circuit’s
states are calculated at intervals of the Master Clock Time.

By default, the Master Clock Time equals the Time Units setting. However,
you can click in the Master Clock Time edit box and change the value. The new
value must be an integer multiple of the Time Units setting. If you choose a
non-integer value, the value is truncated to the next lowest integer multiple. If
you choose a value shorter than the selected Time Units, the Master Clock
Time automatically reverts to the current Time Units setting. 

The Time Unit sets the interval between stimulus values in the stimulus file,
while the Master Clock Time sets the intervals at which the circuit’s internal
states are computed.
You can enter the value you want directly. Or, you can change the base value
by clicking the Time Units radio buttons, then editing the Master Clock Time
shown. For example, if you wanted a Master Clock time of 4 ps, you could
click on the "1.0" and "ps" radio buttons, then go to the Master Clock Time edit
box and change the displayed value from 1.0 ps to 4.0 ps.

The Master Clock Time has a second function. If a node waveform has the
Master Clock Time assigned to it, the timing of its Transitions can be modified
in the Node Parameters dialog box, as explained later in this chapter.

Assign to All Nodes

If the Assign to All Nodes check box is checked (the default), the Master Clock
Time is assigned to all nodes. In general, you should accept this default. You
can use the Node Parameters dialog box to remove the Master Clock Time
from any specific waveform.
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Chapter 3

Command Reference
This chapter describes the commands available in the Waveform Viewer and
Waveform Editor. The following conventions are used:
♦ Commands are listed in alphabetical order: menu first, command second.
♦ Some commands have a keyboard accelerator key. This key is shown in

the following Quick Reference and on the top line of each command
description.

♦ The abbreviations “Viewer” and “Editor” at the right of the header
indicate which program(s) the command appears in. If a command
appears in a different menu in one of the programs, the alternate menu is
shown in parentheses.

♦ The figure belowshows how menus are shown in the reference.

Edit: Hide F5 Viewer, Editor

Menu Command Program(s) in
which command
appears

Keyboard 
shortcut
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Quick Command Reference
Menu: Command Accelerator Program

Edit: Cut Editor
Edit: Copy Editor

Edit: Delete DEL Editor

Edit: Duplicate F6 Viewer, Editor

Edit: Expand Bus Viewer, Editor
Edit: Hide F5 Viewer, Editor

Edit: Insert Pattern Editor

Edit: New Wave Editor

Edit: Node Parameters Editor
Edit: Paste Editor

Edit: Redo SHIFT+F9 Viewer, Editor

Edit: Remove Editor

Edit: Show Viewer, Editor
Edit: Undo F9 Viewer, Editor

File: Consistency Check Editor

File: Copy Externals Editor

File: Exit Viewer, Editor
File: Export Editor

File: New Viewer, Editor

File: Open Viewer, Editor

File: Print Viewer, Editor
File: Print Setup Viewer, Editor

File: Save Viewer, Editor

File: Save As Viewer, Editor

File: View Report Viewer
Help F1 Viewer, Editor
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Menu: Command Accelerator Program

Jump: 10 Left SHIFT+LEFT Viewer, Editor

Jump: 10 Right SHIFT+RIGHT Viewer, Editor

Jump: Next Change + (numeric keypad) Viewer, Editor

Jump: Next Trigger * (numeric keypad) Viewer
Jump: Tick Left LEFT Viewer, Editor

Jump: Tick Right RIGHT Viewer, Editor

Jump: Time=0 HOME Viewer, Editor

Jump: Time=End END Viewer, Editor
Jump: To Marker – (numeric keypad) Viewer, Editor

Jump: To Time Viewer, Editor

Object: Edit Mode Editor

Object: Hide Mark Viewer, Editor
Object: Show Waveform Data Editor

Object: Place Mark Viewer, Editor

Object: Query Mode F2 Viewer, Editor

Object: Set Trigger Viewer
Options: Bus Radix Viewer

Options: Display Options Editor

Options: Setup Options Editor

View: Full Fit CTRL+F Viewer, Editor
View: Full Scale CTRL+S Editor

View: Pan CTRL+W Viewer, Editor

View: Redraw Viewer, Editor

View: Zoom In CTRL+I Viewer, Editor
View: Zoom Out CTRL+O Viewer, Editor
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Edit: Copy Editor

Description
Copies the selected section of the waveform to the Clipboard without
removing it from the waveform. The current contents of the Clipboard are
discarded.

Use
Select the section of the waveform you want to copy, then select the Copy
command. You can then use the Paste command to copy this section elsewhere.

See Also

Edit: Cut

Edit: Delete
Edit: Paste

Edit: Copy
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Edit: Cut Editor

Description
Removes the selected section of the waveform and copies it to the Clipboard.
The current contents of the Clipboard are discarded.

Use
Select the section of the waveform you want to delete, then Select the Cut
command. Use the Paste command (without moving the cursor) or the Undo
command to restore the deleted section.

See Also

Edit: Copy

Edit: Delete
Edit: Paste

Edit: Cut
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Edit: Delete DEL Editor

Description
Removes all or part of a waveform without copying it to the Clipboard. The
current contents of the Clipboard are not affected.

Use
Select the section of the waveform you want to delete, then Select the Delete
command or press DEL to remove the selection. Use the Undo command to
restore the deleted section.

See Also

Edit: Copy

Edit: Cut

Edit: Delete

3-6 Waveform Tools Manual



Edit: Duplicate F6 Viewer, Editor

Description
Copies waveforms from one area of the display to another.

Use
Duplicate is most often used to add copies of global signals, such as clocks, to
have a reference signal near the event being examined. To operate:

1. Click on the name of a single wavefrom to be copied, or drag the mouse
through several names. The selected waves are highlighted in the name
field.

2. Select the Duplicate command from the Edit menu. The selected
waveforms are copied to the bottom of the list.

Edit: Duplicate
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Edit: Expand Bus Viewer, Editor

Description
Divides a bus into its constituent signals.

Use
Select one or more waveforms, at least one of which is a bus. Then select the
Expand Bus command.
The signals are added to the display underneath the existing bus. The original
bus remains in the display, intact.

Note: In the Editor, the constituent components are added to the display as reference
signals only (that is, they can’t be edited).

Edit: Expand Bus
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Edit: Hide F5 Viewer, Editor

Description
Removes waveforms from the display without deleting them from the data
files.

Use
Click on the name of a waveform you want to delete, or select several by
dragging the mouse through their names. Then select the Hide command. The
selected waveforms are removed.

Use the Undo command to immediately restore a hidden waveform. In the
Waveform Editor, you can also use the Show command to restore waveforms.

See Also

Edit: Show

Tools: Find Item (Hierarchy Navigator)

Tools: Probe Item (Hierarchy Navigator)

Edit: Hide
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Edit: Insert Pattern Editor

Description
Inserts a Pattern at the selected point in the waveform.

Use
1. Click at the point in the waveform where you want to insert the Pattern.

♦ If you select a Transition, the Pattern will be inserted at the Transition.
♦ If you select a Pulse or Span, the Pattern will replace your selection.

2. Select the Insert Pattern Command from the Edit menu.

3. In the list box, click on the name of the Pattern you want to insert.

4. Click the Insert button to insert the Pattern.

The Pattern dialog box remains open. You can continue to select insertion
points and insert Patterns without reselecting the Insert Pattern command.
If you change your mind, use the Undo command to remove the inserted
Pattern.

Note: You cannot insert a Pattern into itself. A warning message is displayed if you
try.

Edit: Insert Pattern
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Edit: New Wave Editor

Description
Adds a name to the names section of the window. You can then define a
waveform for the name.

Use
1. Select the New Wave command from the Edit menu. The Add New Wave

dialog box is displayed.

2. Click on the radio button to select the type or polarity of the signal you
want to add.

3. Click in the edit box and type the name.

A Pattern name must begin with a dollar sign ( $ ). If you do not include a
dollar sign, the Waveform Editor will automatically add one.

4. Click on Add or press ENTER to add the name to the list.

The Add New Wave dialog box remains open until you close it. You can
continue to add names without having to reselect the command.

Edit: New Wave
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Edit: Node Parameters Editor

Description
Sets the node characteristics (polarity and timing) of the exported waveform
data. (The source schematics are not modified.)

Use
In asynchronous mode, the Node Parameters command allows you to:
♦ Modify the polarity of a signal 
♦ Assign a state table 
♦ Apply an offset to the waveform

When running in synchronous mode, you can also overlay synchronous
timing information onto the waveforms.

The direct conversion of the waveforms to the appropriate stimulus-file format
is usually all you need. There are, however, several ways to modify the
stimulus data that are written to the test file.
The most common modifications involve changing Pulse timing. The test
stimuli are usually entered with synchronized Transitions. That is, all signals
change state at the same time.

This does not usually happen in “the real world.” A design can often be
simulated more accurately if some variability and delay is introduced into the
timing. The Node Parameters command makes it possible to alter signal
timing.

Selecting the Node Parameters command displays the Node Parameters dialog
box. (Figure 3-1 and Figure 3-2.) Clicking on a node name in the list box
displays the currently selected characteristics of the test waveform for that
node.

Edit: Node Parameters
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To modify a node:

1. Highlight its name in the Nodes list box. There are three ways to select
more than one node:
♦ Drag the cursor across two or more names
♦ Select one name, then press SHIFT while selecting a second name. The

range of names between is highlighted.
♦ Hold down CTRL, then click to select (or deselect) individual names.

2. When more than one node is selected, any changes you make apply to all
selected nodes.

Figure 3-1
Node Parameters Dialog Box

Figure 3-2
Node Parameters Dialog Box with Synchronous Data

Edit: Node Parameters
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Polarity Settings

The Polarity radio buttons let you change the signal polarity of a node in the
stimulus file. This feature is most often used to change BiDir nodes to Input
nodes. Most simulators will not accept stimulus data for Bidirectional nodes,
which must be redefined as Inputs.

To change the polarity of a waveform, highlight it in the list, then click the
appropriate Polarity button.

Note: The Polarity setting affects only the contents of the stimulus file. It does not
change the polarity of the I/O markers in the schematic displayed in the Hierarchy
Navigator.

Offset Settings

The Offset edit box lets you retard every Transition in a waveform by the
amount of time entered. In this way, all the Transitions in the waveforms do
not occur at exactly the same time. Only positive values (delays) can be
entered—Transitions cannot be advanced.

You would generally apply Offsets only to selected waveforms. If all
waveforms in the stimulus set were offset by the same time value, you would
have no net offset.

Type Settings

The Type radio buttons allow you to further modify the Transitions in a
waveform. The default Type is Async (asynchronous). That is, Transitions
occur wherever you have set them.

When you select a Type other than Async, you can then use the Cycle and
Active For settings to add additional Transitions to a waveform. These
Transitions are timed with respect to the Master Clock. Here’s how they work:

♦ The Cycle setting is a multiplier for the Master Clock time. Its default
value is 1, but you can select any positive integer value. (If you enter a
value containing a fraction, the value is truncated to the next-smallest
integer >= 1.) The resulting net Master Clock cycle time is the Master
Clock time defined in the Setup Options dialog box multiplied by the
Cycle value.

♦ The Active For setting is entered as a percentage. The new Transitions in
each Master Clock cycle occur after the percentage of Master Clock cycle
time specified here has elapsed.

You can enter any percentage value. However, the percentage actually
used (as shown by the time value to the right of the Active For edit box) is
rounded off to the nearest fractional part of the Cycle setting.

Edit: Node Parameters
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For example, if Cycle is 2, you can only have percentages of 0, 50, and 100.
If Cycle is 4, you can have percentages of 0, 25, 50, 75, and 100. If (in the
last case), you entered an Active For value of 70, the actual time value
shown (and used) will be rounded up to 75% of the net Master Clock Cycle
Time.

♦ The Type setting determines the type of transition added. There are five
types.

Type Description

Async The default setting. Transitions and Pulses occur without
modification.

NRZ “Non-Return to Zero” — If the waveform is high, it
remains high. If low, it remains low. This is equivalent to
Async, except the Cycle factor can be used.

RZ “Return to Zero” — If the waveform is high, it changes to
low. If low, it remains low.

R1 “Return to One” — If the waveform is high, it remains
high. If low, it changes to high.

RC “Return to Complement” — The waveform changes to
the opposite value.

Any changes begin after the Active For percentage of each net Master Clock
time interval, and remain until the beginning of the next Master Clock time
interval. At that time, the waveform returns to the value defined in the
stimulus file.

If the Assign to All Nodes box in the Setup Options dialog box is checked, the
Master Clock timing will automatically be applied to all nodes. You can use
MC_On and MC_Off radio buttons in the Node Parameters dialog box to
override the default setting for a particular node.

These settings are normally applied only to single-bit waveforms. The NRZ
setting can be applied to bus waveforms, to permit applying scaling and offset.

Edit: Node Parameters
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Example

Assume the Master Clock is set to 0.02 ns, Cycle to 2, Active For to 30, and the
Type to RZ. Then:

♦ The net Master Clock Cycle Time is 0.04 ns.
♦ Since Cycle is 2, the actual Active For percentage is rounded up from 30%

to 50%.
♦ The Active For time interval then becomes (0.04 x 50%), or 0.02 ns.

Suppose that a waveform is high at the beginning of a Master Clock Cycle.
Since the Type is RZ (Return to Zero), after 0.02 ns the value will go low and
remain there for the rest of the cycle. At the start of the next cycle, the
waveform will have whatever value is defined in the stimulus file for that time.

See Also

Setup Options

Edit: Node Parameters
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Edit: Paste Editor

Description
Inserts the contents of the Clipboard at the selected point in the waveform.

Use
1. Click at the point in the waveform where you want to insert the Clipboard

contents.
♦ If you select a Transition, the contents will be inserted at the Transition.
♦ If you select a Pulse (or sequence of Pulses), the contents will replace

your selection.

2. Select the Paste command from the Edit menu.

The pasted contents remain selected. If you change your mind, select the Undo
command or press DEL to remove them.

Edit: Paste
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Edit Redo SHIFT+F9 Viewer, Editor

Description
Reverses changes caused by the Undo command.

Use
As the Undo command “backs up” through the session, a log is kept. Redo can
go forward, recreating the Undone events.
There is no limit to how many Undos or Redos you can perform, until you
Save or Exit. The database is then updated and all Undo/Redo information is
discarded. Do not Save or Exit if there are still changes that you want to Undo
or Redo.
In the Waveform Viewer, Redo is often used to recover hidden waveforms. In
the Waveform Editor you can use it to compare a waveform with and without
an inserted Pattern.

See Also

Edit: Undo

Edit Redo
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Edit Remove Editor

Description
Removes the waveform from the database and the display.

Use

To remove a waveform:

1. Click on the name of a waveform you want to remove, or select several by
dragging the mouse through their names. 

2. Select the Edit: Remove.

3. In the Remove Patterns dialog box (Figure 2-4), select the waveform you
want to remove.

4. Click the Remove button. The selected waveforms are removed.

Use the Undo command to immediately restore a removed waveform. 

Note: The check boxes filter which waveforms are listed in the list box.

See Also

Edit: Show

Edit: Hide

Figure 3-3
Remove Patterns Dialog Box

Edit Remove
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Edit Show Viewer, Editor

Description
Adds waveforms to the display.

Use in the Waveform Viewer
When you select the Show command from the Edit menu, the Hierarchical
Name List dialog box appears. You can choose a signal from any level in the
hierarchy, and combine two or more signals into a “bus” display.

Finding the Signal You Want

The large list box at the left, and the control button above it, are used to
navigate the hierarchy to find the signals you want. The list box initially
displays the letter “t," symbolizing the “top” of the hierarchy. Clicking the
Push button displays the hierarchical level (if any) below the top level.

To move to a lower hierarchical level:

1. Highlight that level in the list box.

2. Click the Push button. (If you are already at the lowest level, the button is
relabeled "Pop," since you can only move upward in the hierarchy.) A
display line below the list box shows the full hierarchical path of the level
you’re currently on.

All signals at a given level are shown in the right list box. 

Figure 3-4
Hierarchical Name List Dialog Box

Edit Show
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To add a signal to the display:

Click on its name, then click the Add Wave button. (Or just double-click on the
signal’s name.)  The signal is immediately added at the bottom of the
Waveform Viewer display.

Creating Multi-Signal “Buses”

You can create a “bus” display of two or more signals. Highlight the first
signal you want in the bus, then click on Add to Bus. The signal is added to the
edit box (at the top left). Continue adding signals this way until the bus is
arranged the way you want it. (You can also click in the edit box, then edit the
list manually to delete or rearrange signals.) Then click on the Show button to
add the bus to the display.

Each new waveform is added at the bottom of the waveform display. The
display automatically scrolls up so you can view the new waveform. A
waveform can be added to the display more than once.

Up to 256 signals can be added to the window at one time. Use the vertical
scroll bar to select the waveforms to view.

Use in the Waveform Editor
Before you can create the stimulus waveforms, you must first display the
names of the associated I/O markers in the left-hand section of the Waveform
Editor’s main window. If you launch the Waveform Editor from the Hierarchy
Navigator, the Navigator passes the names of all the design’s inputs and
outputs to the Waveform Editor.

Select the Show command from the Edit menu. The Show Patterns dialog box
is displayed (Figure 3-5).

Figure 3-5
Show Patterns Dialog Box

Edit Show
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By default, all inputs, outputs, test points, and global signals are listed. You
can narrow the list by clearing one or more of the five check boxes to left of the
list. If you are creating only input stimuli, you would probably want to leave
only the Input and Bidir check boxes checked.

Click on any name, then the Show button, to add the name to the display. You
can also select more than one name at time:

♦ Click on a name and drag the mouse to select names above or below.
♦ Click on a name, then hold down SHIFT and click on a second name to

select all the names between.
♦ Hold down CONTROL and click to select (or deselect) individual names.

In the display, a letter next to the name indicates its type: I for input, O for
output, T for test point, and so on.

The Show Patterns dialog box remains open until you close it, so you can
continue to add names to the list without reselecting the Show command.

See Also

Edit: Hide

Wave: Move

Tools: Find Item (Hierarchy Navigator)
Tools: Probe Item (Hierarchy Navigator)

Edit Show
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Edit Undo F9 Viewer, Editor

Description
The Undo command “backs up” in the edit process.

Use
Undo backs up one event each time it’s issued. It can undo all operations back
to the last time the file was opened or saved. Any command that changes the
data base can be undone.  Commands that alter the display (such as View)
cannot be reversed.

There is no limit to how many Undos or Redos you can perform, until you
Save or Exit. The database is then updated and all Undo/Redo information is
discarded. Do not Save or Exit if there are still changes that you want to Undo
or Redo.

Undo is usually used to recover deleted waveforms and to restore the original
positions of waveforms on the display.

See Also

Edit: Redo

Edit Undo
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File Consistency Check Editor

Description
Calls the check program, which generates errors and warnings about the
stimulus set being created. These errors and warnings are tailored for the
target simulator, and in some cases they may not allow the generation of
stimulus files at all.

Use
Select the Consistency Check command. The check program checks for:

♦ Signal name inconsistencies between the Waveform Editor and the
schematic, such as partial buses or spelling errors. 

♦ Polarity mismatches between the Waveform Editor and the schematic.
♦ Inputs and bidirectionals with defined data that do not exist in the

schematic.
♦ Input and Bidirectional nodes with no data defined for them.  (Other types

of nodes are ignored, since they do not normally have stimuli defined for
them.)

♦ Unused patterns.
♦ Simulator-specific errors related to clocking and delays.

All errors or problems are listed in an edit box. Test point signals are excluded
from the check procedure, because they do not normally represent top-level
I/O nets.

Note: The first three checks listed above can be performed only when the Waveform
Editor is run with the Hierarchy Navigator. Without a schematic loaded into the
Navigator, there is nothing to check against.

File Consistency Check
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File Copy Externals Editor

Description
Loads node names from Hierarchy Navigator when Waveform Editor was
started outside the Navigator.

Use
You can run the Waveform Editor either from within the Hierarchy Navigator,
or by using the Run command from the File menu of either the Program
Manager or File Manager.

In the latter case, if you include the -nav option on the command line, the
Waveform Editor will still be linked to the Hierarchy Navigator, just as if you
had run it from within the Navigator. However, the node names of the
currently loaded project are not automatically copied. (If you select the Edit:
Show command from the Editor, no names will be in the Patterns list box.)

In this case, use the Copy Externals command to copy the node names to the
Waveform Editor.

File Copy Externals
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File Exit

Description
Exits the Waveform Viewer or Waveform Editor.

Use
If the Waveform Viewer’s configuration or the waveforms in the Waveform
Editor have been changed since they were last saved, you are prompted to
perform one of the following:

Save In the Waveform Viewer, saves the latest configuration
changes to the file design.wav (where design is the base
name of the project), then exits. In the Waveform Editor,
saves the latest changes to the list of names and their
waveforms to the files design.wet and design.wdl (where
design is the base name of the project), then exits.

Discard Ignores all configuration and database changes and exits.

Cancel Returns to the program without exiting.

File Exit
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File Export Editor

Description
Creates the simulator stimulus file based on the waveforms you have drawn.

Use
Once you have drawn the stimuli, use this command to create the stimulus file.
If there is no [Export] section in the simulator.ini file, the Export command is
disabled.

If the Export on Save check box in the Setup Options dialog box is checked, the
stimulus files are created each time you save the Waveform Editor files. You
can use this feature to keep the stimulus files up-to-date, without having to use
the Export command from the File menu.

File Export
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File New Editor

Description
Starts a new waveform editing session and clears the waveform and names
windows.

Use
Select the New command. If any changes have been made to the waveforms
since you last saved, you are prompted as to whether you want to save or
discard the changes.

File New
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File Open Viewer, Editor

Description
In the Waveform Viewer, loads a simulation (.sim) file for viewing and
analysis. In the Waveform Editor, loads the .wet and .wdl name and waveform
files.

File Open
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File Print Viewer, Editor

Description
Prints the current waveform display.

Use
A dialog box is displayed with the following controls:

Start Time Time at which the plot is to begin.

Stop (End) Time Time at which the plot is to finish.

Time Scale Scale of plot in nanoseconds/inch. Changing the time
scale changes the number of pages required to display the
waveform.

Sheets Number of sheets to plot the waveforms. The time scale is
automatically adjusted to fill the specified number of
sheets.

Names Width Waveform names are shown in a vertical strip along the
left hand edge of the page. This parameter determines the
width of this strip.

Names on Sheets The Names strip is printed on every page if the Names On
All Sheets check box is marked. Otherwise only the first
sheet displays the names of waveforms, and more display
space is on the following sheets.

Figure 3-6
Print Waveforms Dialog Box

File Print
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Portrait Displays the time axis along the short edge of the paper.

Landscape Displays the time axis along the long edge of the paper.
This is the default.

Print Sends the plot to the printer, using the current settings.

Set the options as desired, then click on the Print button. Note that Time, Time
Scale, and Sheets values are interactive. If you change the Start Time, End
Time, or Sheets, the Time Scale will change automatically to accommodate the
change. (Click in the Time Scale edit box to see the Time Scale change.)
Similarly, changing the Time Scale will change the number of Sheets needed to
print the display. 

If you decide not to print, double-click on the System button at the upper-left
corner of the dialog box to close it.

File Print
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File Print Setup Viewer, Editor

Description
Calls the Windows function that sets print options.

Use
The most commonly used option is Orientation. Most text documents are
printed with the long edge of the paper vertical: portrait orientation. Most
waveform displays are printed with the long edge horizontal: landscape
orientation.

The default setting for Synario is Landscape, and this is the orientation you
would normally use. Switching to Portrait orientation would chop off about
one third of the display. You would most likely select Portrait when you want
to see a relatively small section of the waveforms in greater detail.

The other options, such as file type, paper tray, and so forth, vary with the
printer. Please refer to your printer’s manual for information on these options.

See Also

File: Print

File Print Setup
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File Save, Save As Viewer, Editor

Description
Saves the current work session configuration. The Save As command performs
the same actions, but saves to a filename you specify. Save As also saves the
waveform database as a binary file. You can recall this data at any time for
further analysis or comparison with other simulations.

Waveform Viewer

The configuration information is stored in a file with the .wav extension and
the same base name as the database information. This file includes the names
of the waveforms currently displayed and any triggers currently defined.
The default extension of the binary database file is .bin. The root name is
determined from one of the following:

♦ The design name (if the waveforms originated from the simulation
interface).

♦ The name of the Timewave history file (if the waveforms originated from a
Timewave history file).

♦ The name of the binary history waveform file (if the waveforms originated
from a binary waveform file).

Waveform Editor

The database is stored as a file with the .wav extension containing the names
of the nodes for which you have defined waveforms, and a file with the .wdl
extension with a description of the waveforms themselves.

See Also

File: Open

File Save, Save As
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File View Report Viewer

Description
Displays hazard information and/or any other information that is best viewed
with waveforms.

Use
A dialog box lets you choose the file name to open. The default file name is
design.haz. The file must be in the following format:

error_time1 net_name1 comment

error_time2 net_name2 comment

where error_time is an integer representing the number of ticks from T=0 and
net_name is a Schematic Editor hierarchical net name. The comment field is any
text information. The fields are separated by one or more spaces.

The file contents are displayed in a list box. Clicking on a line (typically a
hazard or other error condition) jumps the display to the time specified at the
beginning of the line. The Waveform Viewer also highlights the specified net if
it is contained in the waveform display window. The Hierarchy Navigator, if
connected, jumps to highlight the problem net.

View Report displays error conditions at or following the current Query cursor
time. Error conditions prior to that time are not shown in the list box.

File View Report
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Help F1 Viewer, Editor

Description
Accesses the Help system, for information about commands and procedures.

Use
Online help is available at any time. Choose the Contents command from the
Help menu to enter the top level of the help system for the Waveform Viewer.
Or choose the Search for Help On command to select from a list of Waveform
Viewer topics. 

Most commands remain active until you select another command. To get help
on the currently active command, simply press F1.
If you’re not familiar with the Microsoft Help System, the How to Use Help
command explains how to navigate the system.

Help 
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Jump Menu
Jump: 10 Left SHIFT+LEFT Viewer, Editor

Description
Moves the query cursor one major tick mark to the left (“backwards” in time).
The interval between tick marks changes as you change the time scale with the
View commands.

See Also

Jump: 10 Right

Jump: Tick Left
Jump: Tick Right

Jump: 10 Right SHIFT+RIGHT Viewer, Editor

Description
Moves the query cursor one major tick mark to the right (“forward” in time).
The interval between tick marks changes as you change the time scale with the
View commands.

See Also

Jump: 10 Left

Jump: Tick Left

Jump: Tick Right

Jump Menu 
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Jump: Next Change + (numeric keypad) Viewer, Editor

Description
Moves the query cursor to the next transition in the currently selected signal.
If the currently selected signal is a bus, the query cursor moves to the next
transition of any signal in the bus.

Use
Next Change is typically used to traverse the simulation data. Starting at a
primary input (which is the most common activity initiator), you can jump
from one initiating event to another. You can find later events on other signals
that result from the changes on the primary input.

See Also

Jump: Next Trigger

Jump: Next Trigger * (numeric keypad) Viewer

Description
Advances the query cursor to the next time that satisfies the specified trigger
conditions. The display is automatically repositioned to place the new query
time at the center of the display.

See Also

Jump: Next Change

Object: Set Trigger

Jump: Tick Left LEFT Viewer, Editor

Description
Moves the query cursor one tick mark to the left (“backwards” in time). The
interval between tick marks changes as you change the time scale with the
View commands.

See Also

Jump: Tick Right
Jump: 10 Left

Jump: 10 Right

Jump Menu 
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Jump: Tick Right RIGHT Viewer, Editor

Description
Moves the query cursor one tick mark to the right (“forward” in time). The
interval between tick marks changes as you change the time scale with the
View commands.

See Also

Jump: Tick Left

Jump: 10 Left

Jump: 10 Right

Jump: Time=0 HOME Viewer, Editor

Description
Moves the query cursor to time = 0. This is the left-most point on the time axis
of the waveform.

See Also

Jump: Time=End

Jump: Time=End END Viewer, Editor

Description
Moves the query cursor to the last time point of the simulation. This is the
right-most point on the time axis of the waveform.

See Also

Jump: Time=0

Jump Menu 
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Jump: To Marker – (numeric keypad) Viewer, Editor

Description
Positions the query cursor at the marker and centers the display at the marker.

Use
The principal use of To Marker is simply to return the query cursor to the
marker. This is especially useful when you are displaying the time line at high
magnification, and you would have to press SHIFT+LEFT or SHIFT+RIGHT many
times to return to the marker.

See Also

Jump: Next Change

Jump: Next Trigger

Jump: To Time Viewer, Editor

Description
“Pans” the waveform display to a specified time.

Use
Use the following procedure to examine the waveforms at any specified time:

1. Select the To Time command from the Jump menu. A dialog box is
displayed as shown in Figure 3-7.

2. Enter the desired time. Click the OK button.

3. The waveform display—and the Query cursor—move to the specified time.

Click the Cancel button to cancel the jump.

See Also

Jump: Time=0
Jump: Time=End

Figure 3-7
Jump to Time Dialog Box

Jump Menu 
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Object Edit Mode Editor

Description
Switches the Waveform Editor’s operating mode to Edit and displays the
editing Toolbox.

Use
The default mode of the Waveform Editor is Edit. Switching to Query mode
disables the editing functions, so that clicking on a waveform will not select
Pulses or alter them. Use the Edit command to return to Edit mode.

The editing Toolbox is normally displayed in Edit mode. You can close the
Toolbox by double-clicking on its System button. To restore the Toolbox, select
the Edit command.

Object Edit Mode
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Object Hide Mark Viewer, Editor

Description
Removes the marker from the waveform display. It’s useful when you print a
section of the waveform display and don’t want the marker to be visible.

See Also

Object: Place Mark

Object: Query

Object Hide Mark
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Object Place Mark Viewer, Editor

Description
In the Waveform Viewer, inserts the marker (a dashed, colored, vertical line) at
the current location of the query cursor. The display pans to this location.

In the Waveform Editor, the current position of the cursor becomes the
marker. It is a solid line.

Use
The marker is useful as a reference point for measuring times between events.
While the Query command is in effect, the time difference between the time at
the query cursor and the time at the marker is displayed on the prompt line.

See Also

Object: Hide Mark

Object: Query

Object Place Mark
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Object Query Mode F2 Viewer, Editor

Description
Switches to Query mode (in the Waveform Editor). The Query command is the
default operating mode for the Waveform Viewer. You do not need to select
the Query command unless you are quitting another command.

Use

To query a waveform:

1. Position the query cursor over the waveform, with the arrow cursor at the
desired time.

2. Click to select the waveform.

The query-cursor time and the logic level of the selected signal are displayed
on the prompt line. If the selected signal is a bus, the bus’s value is displayed.

If the marker was previously placed, the time difference between the marker
and the query cursor is shown as Delta on the prompt line. This is an easy way
to measure the time between events.
In the Waveform Viewer, there are several other options for selecting new
times or waveforms:

♦ To select a new query time without changing the selected waveform, click
(or drag) on the time scale. (At least half the cursor must fall within the
time scale, or you will also select the top waveform.)

♦ To select a new waveform without changing the query time, click in the
names region.

♦ You can add a waveform to the display by clicking on its net in the
schematic when the Probe Item command of the Hierarchy Navigator is
active. The added waveform becomes the selected waveform.

♦ Any Jump command can be used to change the selected wave or time.

Query is used with the Find Item command from the Hierarchy Navigator to
find the device driving a particular waveform:

1. Use Query to select the required waveform.

2. Select Find Item from the Hierarchy Navigator’s Tools menu.

The Navigator determines if a signal is driving a net by checking the polarity
of pins tied to the net. Output pins are considered to be driving. The first
output pin found is displayed when using Query.

Object Query Mode
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The Navigator displays the schematic with the component that’s driving the
selected waveform. The net associated with the selected waveform is
highlighted.

The Query command in the Waveform Viewer works in conjunction with the
Query command in the Navigator if the Query box in the Navigator is open.
The Navigator Query box then reflects the currently selected waveform in the
Waveform Viewer.

See Also

Object: Place Mark

Tools: Find Item (Hierarchy Navigator)

Tools: Probe Item (Hierarchy Navigator)

Object Query Mode
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Object Set Trigger Viewer

Description
A trigger is a specific set of circuit states. Triggers can be set for more than one
signal or bus.

Use

To set a trigger for a signal:

1. Select the Set Trigger command from the Object menu. The Trigger dialog
box offers the following trigger conditions:
♦ High: Low
♦ Positive Edge: Negative Edge
♦ Change
♦ Unknown

2. In the Waveform Viewer, click on the waveform that is to have a trigger
state, then click on the Add button. The signal’s name is displayed in the
list box.

3. Click on the radio button for the desired trigger condition. (Note that the
trigger conditions are mutually exclusive; only one can be selected.)

4. Repeat steps 2 and 3 until all trigger conditions are specified.

A trigger condition on a bus is based on the state of each signal in the bus. The
trigger condition for a bus has one character for each signal in the bus. The
character can be 0, 1, or X (“don’t-care”). Any state matches an X.

Figure 3-8
Set Trigger Dialog Box

Object Set Trigger
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To set a trigger for a bus:

1. Select the Set Trigger command. The Trigger dialog box is displayed.

2. In the Waveform Viewer, click on the bus waveform that is to have a
trigger state, then click the Add button. The bus’s name and binary value
appear in the list box.

3. Edit the Bus Value edit field to match the binary bus value to be used as a
trigger.

4. Repeat steps 2 and 3 until all bus trigger conditions are specified.

Signal and bus triggers can be mixed. All active triggers are displayed in the
list box. When the triggers are set as you want them, close the dialog box.

To remove a trigger condition:

1. Select the Set Trigger command.

2. Click on the desired signal from the list box.

3. Click on Delete.

The current state of the trigger conditions is normally displayed on the prompt
line. The trigger state is sometimes briefly overwritten by status messages from
commands.

See Also

Jump: Next Trigger

Object Set Trigger
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Object Show Waveform Data Editor

Description
Displays the waveform data for a node.  The Waveform Data display allows
you to see the hierarchical composition (using patterns) of a wave.

Use
1. Select the Show Waveform Data command from the Object menu. The

Waveform Data dialog box is displayed.

2. Click on the name of the waveform (or the waveform itself) you want to
study.

3. The Waveform Data dialog box displays the waveform data.

The Waveform Data dialog box remains open until you close it. You can
continue to select names.

Object Show Waveform Data
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Options Bus Radix Viewer

Description
Changes the bus radix and various waveform display characteristics.

Use
A dialog box is displayed with four radio buttons, one for each radix: Binary,
Octal, Decimal, and Hexadecimal. Click on the radio button of the base you
want, then close the dialog box.

Options Bus Radix
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Options Display Options Editor

Description
The display options command gives you control over the following items
displayed in the Editor:

♦ The bus radix
♦ Guidelines
♦ Pattern names and waveforms
In Synchronous mode, it also allows you to select if waveforms are
synchronized or not.

Use

To control the display:

1. Select Options: Display Options.

2. Click on the desired radio buttons and check boxes.

Options Display Options
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Options Setup Options Editor

Description
Sets the basic simulation time parameters. Also activates auto-export mode.

Use The Setup Options dialog box is shown in Figure 2-9.

Note: The master clock control features (Master Clock Time and Assign to All
Nodes) are available only in Synchronous mode.

Time Units

The Time Units radio buttons select the time interval for the simulation
database. In the simulation stimulus file, stimulus values are specified at
intervals of this Time Unit.

It’s important to understand that all stimulus events occur at, and have lengths of,
integral multiples of the Time Units. This feature makes it easier to draw
waveforms (as explained below), because all transitions are automatically
forced to occur at multiples of the Time Units.

Simulation Time

The Simulation Time is the total run time for the simulation. The default value
is 1,000,000 times the Times Unit value. For example, if the Time Unit selected
is 0.01 ns, the default value in the Simulation Time edit box is 10,000.0 ns. You
can change the Simulation Time by clicking in the edit box and typing the
value you want.

Figure 3-9
Setup Options Dialog Box

Options Setup Options
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Note: A long Simulation Time combined with short Time Units may require an
excessive amount of computer time. Be sure you have selected values appropriate for
your design before you begin simulation.

Master Clock Time

The Master Clock Time sets the simulation’s resolution. That is, the circuit’s
states are calculated at intervals of the Master Clock Time. By default, the
Master Clock Time equals the Time Units setting. However, you can click on
the Master Clock Time edit box and change the value. The new value must be
longer than the Time Units setting. If you choose a shorter value, the Master
Clock Time will revert to the Time Units setting.

It’s important to understand the difference between the basic Time Unit and
the Master Clock Time. The Time Unit sets the interval between stimulus
values in the stimulus file. The Master Clock Time sets the intervals at which
the circuit’s internal states are computed.

You can enter the value you want directly. Or, you can change the base value
by clicking the Time Units radio buttons, then editing the Master Clock Time
shown. For example, if you wanted a Master Clock time of 4 ps, you could
click on the "1.0" and "ps" radio buttons, then go to the Master Clock Time edit
box and change the displayed value from 1.0 ps to 4.0 ps.

Assign to All Nodes

If the Assign to All Nodes check box is checked (the default), the Master Clock
Time is assigned to all nodes. In general, you should accept this default. You
can use the Node Parameters dialog box to remove the Master Clock Time
from any specific waveform.

Exporting

When the Export On Save box is checked, the simulation file is created
automatically each time you save your waveform data. If the box is not
checked, you have to explicitly create the simulation file using the Export
command.

Setting Export on Save means that your simulation file is always ready.
However, it takes additional computer time to create this file and write it to
disk. If you save your work often, the loss of time may be more inconvenient
than having to use the Export command.

Options Setup Options
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View Full Fit CTRL+F Viewer, Editor

Description
Changes the time-scale magnification to display the full duration of the current
waveforms. Subsequent use of the command toggles the scale between the
original magnification and the full-scale display. By toggling, you can alternate
between the complete waveform and an area of particular interest.

Use
When Full Fit is invoked, the cursor changes to the zoom cursor (the letter Z).
Full Fit has two modes, Click and Drag:

Click

Clicking left toggles between the magnification in place before the command
was invoked and full-scale:

1. Click left in the waveform window. The complete waveform duration fills
the window.

2. Move the cursor to the time point you’d like to see in more detail and click
left.

The window returns to the magnification before Full Fit was used. It also
centers the window where you clicked the second time. (This may not be the
center of the screen if the point is near either end of the waveform.)
Additional clicks toggle between the original magnification and the total
waveform duration. This is a quick way to move around a waveform, looking
at various areas in detail.

Drag

Drag mode lets you scale the display in a single operation:

1. Click left to fill the screen with the current waveform.

2. Drag the mouse from the first time point you want to view to the second,
then release the button. The time span between the two points is
highlighted on the display’s timescale.

The selected time slice is centered in the window. The magnification is set to
the largest value that still allows the complete time slice to be viewed.

View Full Fit
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Drag mode can be repeated by clicking left to display the full time duration,
then dragging through the area to be viewed.
Click right anywhere in the window to terminate Full Fit and restore the
previous command. Selecting any other command also terminates Full Fit.

The View commands are “nested” commands. If invoked while another
command (not a View command) is in progress, the active command’s status is
saved while the View command is executed. When the View command is
terminated by clicking right, the previous command is restored.

View Full Fit
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View Full Scale Editor

Description
Expands the time scale so that waveforms are displayed at full (or nearly full)
magnification. That is, each tick mark represents one (or ten) Master Clock
interval(s).

Use
Select the Full Scale command and click in the waveform window.

View Full Scale
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View Pan CTRL+W Viewer, Editor

Description
Slides the current viewing window across the waveforms being viewed.

Use
Click at the point on the waveform to be centered in the window. The window
is immediately redrawn with the new center point, at the current
magnification. (If the point is near the edge, it may not be centered.)

Click right anywhere in the window to terminate Pan and restore the previous
command. Selecting any other command also terminates the Zoom.

The View commands are “nested” commands. If invoked while another
command (not a View command) is in progress, the active command’s status is
saved while the View command is executed. When the View command is
terminated by clicking right, the saved command is restored.

View Pan
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View Redraw Viewer, Editor

Description
Repaints the current window.

Use
Some operations can leave “trash” pixels or incomplete lines. Use the Redraw
command to clean up the image. The screen is redrawn as soon as this
command is selected.

View Redraw
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View Zoom In Viewer, Editor

Description
Zoom In doubles the current magnification, showing a section of the current
waveform in more detail.

Use
The Zoom In command has both a Click and a Drag mode:
♦ Click at the waveform point you want to be centered. The window is

immediately redrawn with the new center point at the next-higher
magnification. (The point might not be centered if it is near either end of
the waveform.)

Or...

♦ Drag the mouse from the first time point you want to view to the second,
then release the mouse button. The time span between the two points is
highlighted on the display’s timescale. The time slice is centered and the
magnification set to the largest value that allows the complete time slice to
be viewed.

Click right anywhere in the window to terminate Zoom In and restore the
previous command. Selecting any other command also terminates the Zoom.
The View commands are “nested” commands. If invoked while another
command (not a View command) is in progress, the active command’s status is
saved while the View command is executed. When the View command is
terminated by clicking right, the saved command is restored.

View Zoom In
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View Zoom Out Viewer, Editor

Description
Zoom Out decreases the current window magnification on the time axis and
displays more of the current waveforms in less detail.

Use
Click at the point you want to be the new center. The screen is immediately
redrawn with one-half the previous magnification and the new center point.
(This might not be the center of the screen if the point is near either end of the
waveform.)

Click right anywhere in the window to terminate Zoom Out and restore the
previous command. Selecting any other command also terminates the Zoom.

The View commands are “nested” commands. If invoked while another
command (not a View command) is in progress, the active command’s status is
saved while the View command is executed. When the View command is
terminated by clicking right, the saved command is restored.

View Zoom Out
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Appendix A

The Waveform Description
Language
The Waveform Editor uses a data model called the Waveform Description
Language (WDL). This language represents a waveform as a sequence of
signal states separated by time intervals. The language also has constructs that
let you express the waveform pattern hierarchically.

The following information is provided for those who want to create their own
WDL files, or understand the files the Waveform Editor creates. You do not
have to be familiar with the Waveform Description Language to use the
Waveform Editor.

Language Definition
The basic WDL construct is the Pattern. (A WDL Pattern has no relationship to
a Waveform Editor Pattern.) A Pattern is a sequence of states and the
durations of the states. For example, a Pattern named $P1, with a value of 0 for
10 time units, followed by a value of 1 for 20 time units, is defined as

$P1 = (0 10 1 20);

A Pattern remains in its last specified state indefinitely.

Patterns must be named before they can be referenced. Pattern names begin
with a dollar sign ( $ ) to distinguish them from node names. Pattern
definitions must be terminated with a semicolon ( ; ).

A Pattern represents a single signal (one bit). A Pattern can be assigned one of
256 state values (level + strength).

Bus Patterns

Patterns can have a width greater than one, to represent bus signals. The
maximum width is 32 bits. Bus values are represented in hexadecimal. The
following is an eight-bit bus Pattern:

$Bus_P1[0:7] = (02 10 04 20);
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Embedded Patterns

A Pattern can contain another Pattern. The embedded Pattern is specified by
including its name in the sequence:

$P1 = (0 10 $P2 1 20);

Embedded Patterns should have the same width as the Pattern to which they
are added:

$Bus_P3[0:7] = (02 10 04 20 $Bus_P2[0:7]);

If you paste an the embedded Pattern that is wider than the pattern in which it is
pasted, the data is truncated without warning.  If the embedded Pattern is
narrower, the unassigned bits are set to 0.

Repeated Patterns

A Pattern can be repeated by following it with a repeat count. If no repeat is
specified, the default value is 1. In the following example, the Pattern is
repeated a five times:

$P1 = (0 10 1 20)#5;

Scaled Patterns

The time intervals in a Pattern can be scaled by an integer multiplier. In the
following example, all time intervals are multiplied by three:

$P1 = (0 10 1 20)*3;

You can also scale embedded Patterns. This makes it easy to write library
Patterns based on the unit time, then scale them as needed. In the following
example, the time intervals in the embedded Pattern are multiplied by four:

$P1 = (0 10 $P2*4 1 20);

Assigning Patterns to Net or Bus Names

Patterns can be assigned to net or bus names. If the Pattern is wider than the
net or bus, the low-order bits are kept. If the Pattern is narrower, the
unspecified bits are set to 0. For example, the net Net_One is assigned to a
single bit Pattern $P1:

Net_One = $P1;

The bus Bus_One has bits 0-7 assigned to Pattern $Bus_P1, and bits 8–157 set to 0:

Bus_One[0:15] = $Bus_P1[0:7];

The Waveform Description Language
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Infinite Repeat in Patterns

An infinite repeat is specified with two consecutive pound signs ( ## ). An
infinite repeat can be applied only to nets or buses, not to Pattern definitions.
For example, to repeat a series of Pulses assigned to a signal forever:

Net_Two = (0 10 1 10)##;

Delimiting the Scope of Scaling and Repeating

Parentheses delimit the scope of scaling and repeating operations. You can
have as many levels of parentheses as you want. The only restriction is that
“repeat forever” is limited to the highest level. So, the following is valid:

Net_Three = ((0 10 1 20)#5 (0 20 1 10)#3)##;

but

Net_Four = ((0 10 1 20)## (0 20 1 10)#3)#5;

is not valid. The latter section of the pattern never runs.

The Waveform Description Language
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Language Constraints
The WDL has the following limits and restrictions:

♦ Pattern names can be up to 24 characters, including any bus dimension.
♦ Pattern names must begin with a dollar sign ( $ ), and can contain any

alphanumeric character and the underscore ( _ ).
♦ The repeat-count range is 1–65534 for each parenthetical level, or forever

at the outermost level. The default value for the repeat count is 1.

Net_Five = (((0 10)#65534)#65534)##;

♦ The scale-factor range is 1–65534 (with a default value of 1).

$P1 = ((0 10)*65534)*65534);

♦ Up to 256 waveforms can be assigned to the wave window at the same
time.

♦ Net and bus names can be up to 256 characters.
♦ A single bit can have from 0–255 state values. These values are mapped via

state tables.
♦ Multi-bit signals can take only 0 or 1. Values of X (unknown) or Z (high

impedance) are not permitted.
♦ The maximum number of time units is 232 - 1 (4,294,967,295).
♦ A single database can contain up to 1024 Patterns.
♦ Blanks (spaces), tabs, and commas are all treated as delimiters.

 

The Waveform Description Language
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Index

B
Bus expansion, 3-8
Bus pulses, 2-11
Bus Radix

command, 3-48
defined, 3-48

Bus triggers, 3-46
Buses

creating, 3-21

C
Consistency Check command, 3-24
Copy command, 3-4
Copy Externals command, 3-25
Cut command, 3-5

D
Delete command, 3-6
Displaying waveforms, 3-20 – 3-21
Duplicate command, 3-7
Duplicating waveforms, 3-7

E
Edit Mode command, 3-40
Exit command, 3-26
Expand command, 3-8
Expanding a bus, 3-8
Export command, 3-27

F
Full Fit command, 3-52 – 3-53
Full Scale command, 3-54

H
Hazard information

displaying, 3-34
format, 3-34

Help command, 3-35 – 3-39
Hide command, 3-9
Hide Mark command, 3-41
Hiding waveforms, 3-9
Hierarchy Navigator

repeating commands, 3-18

I
Insert Pattern command, 3-10

M
Marker

hiding, 3-41
placing, 3-42

N
New command, 3-28
New Wave command, 3-11
Next Change command, 3-37
Next Trigger command, 3-37
Node Parameters command, 3-12 – 3-16
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O
Open command, 3-29

P
Pan command, 3-55
Paste command, 3-17
Pin Attribute command, 3-1
Place Mark command, 3-42
Print command, 3-30 – 3-31
Print Setup command, 3-32
Printer setup, 3-32
Printing waveform display, 3-30
Pulses

bus, 2-11

Q
Query command, 3-43 – 3-44
Query cursor

moving, 3-36 – 3-39
Querying waveforms, 3-43

R
Redo command, 3-18
Redraw command, 3-56
Remove command, 3-19
Repeating commands, 3-18

S
Save As command, 3-33
Save command, 3-33
Saving Waveform Editor database, 3-33
Saving Waveform Viewer database, 3-33
Set Trigger command, 3-45 – 3-46
Setup Options command, 3-50 – 3-51
Show command, 3-20 – 3-22
Show Waveform Data command, 3-47
Showing waveforms, 3-20 – 3-21
Simulation files

loading, 3-29
Simulation values

displaying in schematic, 1-8
Simulator

required for Waveform Viewer, 1-1
State tables

creating, 2-24
format, 2-24

T
10 Left command, 3-36
10 Right command, 3-36
Tick Left command, 3-37
Tick Right command, 3-38
Time=0 command, 3-38
Time=End command, 3-38
Timewave history file

See SCS User Manual
To Marker command, 3-39
To Time command, 3-39
Trigger

bus, 3-46
conditions, 3-45
defined, 1-7, 3-45
display, 1-2
removing, 3-46
setting, 3-45

Trigger command, 3-45 – 3-46
Trigger conditions

display, 1-2
Triggers

defined, 1-7
setting, 1-7
signal conditions, 1-7

U
Undo command, 3-23
Undoing commands, 3-23

V
View Report command, 3-34

Index
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W
Waveform

querying, 3-43
Waveform Description Language

described, A-1 – A-4
Waveform Editor

changing parameters, 2-10
configuring, 2-26
creating stimulus file, 2-17
displaying name, 2-4
displaying waveforms, 3-21
drawing Patterns, 2-12
drawing waveforms, 2-8
editing waveforms, 2-9
forcing nodes, 2-6
hiding/restoring waveforms, 2-6
interaction with Hierarchy Navigator, 2-4
printing display, 3-30
running, 2-1
saving current database, 3-33
selecting parts of waveforms, 2-11
setting parameters, 2-26
state tables, 2-24
timing adjustments, 2-18
use, 2-3
viewing values on schematic, 2-17

Waveform Viewer
analysis techniques, 1-7
bus logic values, 1-4
bus radix setting, 3-48
bus triggers, 3-46
configuration variables, 1-10
creating buses, 3-21
cross-probing, 1-4
described, 1-1
display commands, 1-5
displaying error information, 1-9
displaying hazard information, 3-34
displaying signals, 1-3
displaying simulation values in schematic, 1-8
displaying waveforms, 3-20
expanding a bus, 3-8
Find Item command, 1-8
functions, 1-1
hiding marker, 3-41
hiding waveforms, 3-9
interaction with Hierarchy Navigator, 1-8

jumping to events, 1-6
loading simulation files, 3-29
locating nets, 1-8
logic-level measurements, 1-7
moving query cursor, 3-36 – 3-39
placing marker, 3-42
printer setup, 3-32
printing display, 3-30
printing the display, 1-9
Probe Item command, 1-8
Probe Item command from Hier. Nav., 1-4
prompt line, 1-2
Query Command, 1-8
querying waveform, 3-43
removing triggers, 3-46
saving configuration, 1-9
saving current database, 3-33
selecting waveforms to view, 1-3
setting triggers, 1-7
Show command, 1-3
simulation value display, 1-8
simulator required, 1-1
starting, 1-1
time-difference measurements, 1-8
trigger, 1-7
trigger conditions, 3-45
trigger setting, 3-45
triggers defined, 1-7
undoing commands, 3-23
viewing controls, 3-52, 3-55 – 3-58
waveform analysis, 1-7
window components, 1-1

Waveforms
duplicating, 3-7
hiding, 3-9

WDL
described, A-1 – A-4

Z
Zoom In command, 3-57
Zoom Out command, 3-58

Index
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